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Comprehensive Interactive User Manual

Major Update: Now includes comprehensive Floor Plan Designer documentation with 2D/

3D design capabilities, NexusConnectBridge integration, and enhanced UI navigation.
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Getting Started

System Requirements

Minimum Requirements: - Operating System: Windows 10, macOS 10.15, or Linux Ubuntu 18.04+ -

Browser: Chrome 90+, Firefox 88+, Safari 14+, Edge 90+ - RAM: 4GB minimum, 8GB recommended

- Storage: 1GB available space - Internet: Broadband connection (10 Mbps minimum)
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Recommended Requirements: -  RAM: 16GB for optimal performance -  Graphics: Dedicated GPU

for 3D visualization -  Display:  1920x1080 minimum resolution -  Internet:  25 Mbps for real-time

collaboration

Accessing NexusConnect

Open  your  web  browser and  navigate  to:  https://nexusconnect-anc-

j67aj6.automatacontrols.com

Bookmark the URL for quick access

Wait for the application to load - you'll see the NexusConnect logo with spinning animation

User Registration & Login

First-Time Registration

Click "Create Account" on the login screen

Fill in your information:

Username: Choose a unique identifier (3-20 characters)

Email: Valid email address for account verification

Password: Minimum 8 characters with mixed case and numbers

Confirm Password: Re-enter your password

Click "Create Account" button

Check your email for verification (if required)

Return to login screen and sign in

Signing In

Enter your username and password

Check "Remember me for 30 days" if desired (optional)

Click "Sign In"

Wait for authentication - you'll see a success message

Password Visibility Toggle

Click the eye icon next to password fields to show/hide password text

Use Tab key to navigate between fields efficiently
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Interface Overview

Upon successful login, you'll see the Mode Selection screen:

Mode Selection Screen

Control Mode: Traditional HVAC schematic design

AI Model Mode: Machine learning and data science tools

Choose your primary workflow - you can switch modes anytime

Main Interface Layout (Control Mode)

Top Bar - Toolbar:

[File] [Edit] [View] [Config] [Logic] [Generate Logic] [AI Model] [?]

Left  Panel  -  Component  Library: -  Expandable  categories  of  HVAC  components  -  Search

functionality - Drag-and-drop interface

Center - Canvas: - Main design area - Grid background for alignment - Zoom and pan controls

Right Panel - Properties: - Component configuration - Project information - Wire specifications

Bottom - Footer: - Application status - User information - Version details

Application Modes

Control Mode

Purpose:  Design  professional  HVAC  control  schematics  Best  For:  -  Control  engineers  -  HVAC

technicians - Building automation professionals - Electrical designers

Key Features: - IEEE-compliant component symbols - Smart wire routing - Electrical validation -

Professional drawing standards
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AI Model Mode

Purpose: Create and train machine learning models for HVAC systems Best For: - Data scientists -

Research engineers - Facility managers - Performance analysts

Key Features: - Visual neural network design - 72 curated HVAC datasets - 3D model visualization -

Jupyter notebook generation

Floor Plan Designer

Purpose:  Design  building  layouts  with  integrated  HVAC  systems  Best  For:  -  Architects  -  MEP

engineers - Building designers - Facility planners

Key Features: - Interactive 2D/3D floor plan design - 202-component NexusConnectBridge library

(95 2D SVG + 107 3D GLB) - Advanced wall  drawing tools - Equipment placement and sizing -

Piping  and  ductwork  routing  -  Layer-based  design  management  -  AI-assisted  design  with

NexusForge - Real-time 3D visualization - Professional rendering and export

Switching Between Modes

Navigation Buttons (Recommended)

Enhanced UI Navigation: Each mode now includes direct navigation buttons:

From Floor Plan Designer: - AI Model button: Switch to AI Model Mode - Control button: Switch to

Control Mode

From AI Model Mode: - Floor Plan button: Switch to Floor Plan Designer

From Control Mode:

- Floor Plan button: Switch to Floor Plan Designer

Traditional Mode Toggle

Click the mode toggle in the top toolbar

Select your desired mode from the dropdown 

Confirm the switch - your work is automatically saved

Wait for interface reload - mode-specific tools will appear
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Tip: Use the navigation buttons for faster switching between related design tasks!

Floor Plan Designer - Building Layout Design

Overview {#floor-plan-overview}

The Floor Plan Designer is a powerful building layout design tool that integrates seamlessly with the

NexusConnectBridge  Component  Library.  Design  professional  floor  plans  with  accurate  HVAC

equipment placement, piping, and ductwork routing.

Key Capabilities: - 2D Design Mode: Traditional architectural floor plan design - 3D Visualization:

Real-time  isometric  3D  rendering  -  Hybrid  Mode:  2D  design  with  3D  component  previews  -

Component  Integration:  Access  to  202  professional  HVAC  components  -  AI  Assistance:

NexusForge intelligent design suggestions

2D Floor Plan Design

Getting Started

Access Floor Plan Designer

Click "Floor Plan" from the main menu

Or use the navigation buttons in Control/AI Model modes

Interface Layout [Toolbar: AI Model | Control | Save | Export | NexusForge | 2D View]

[Left Panel: Component Library Tabs - Standard | 3D] [Center: Canvas with Grid | Zoom

Controls | Layer Panel] [Right Panel: NexusForge Chat (toggle)]

Canvas Operations

Navigation: -  Pan: Click and drag on empty canvas -  Zoom: Mouse wheel or +/- buttons -  Grid

Toggle: Click grid button in toolbar - Reset View: Double-click on empty canvas
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Basic Tools: -  Select Tool: Click to select components/walls -  Wall Tool: Draw building walls and

partitions

- Room Tool: Add rooms and spaces - Equipment Tools: Place HVAC components

Wall Drawing Tools

Interactive Wall Drawing

The advanced wall drawing system provides professional architectural drafting capabilities:

Start Drawing

Select the Wall tool from toolbar

Click anywhere on canvas to start first point

Interactive Preview

Move mouse to see grey dotted line preview

Line shows exact wall placement before confirmation

Complete Wall

Click second point to finish wall

Wall automatically snaps to grid if enabled

Continuous Drawing

After placing a wall, start next wall from endpoint

Create complex floor plans efficiently

Branch Walls

Click on any existing wall to start new wall from that point

Create T-junctions and complex layouts easily

Cancel Drawing

Press ESC key to exit wall drawing mode

Returns to select tool automatically

Wall Types: - Exterior: Heavy structural walls - Interior: Standard room dividers

- Partition: Lightweight dividers

Wall  Properties: -  Thickness:  4-12  inches  -  Height:  Automatic  (8-12  feet)  -  Material:  Drywall,

concrete, etc.
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Room Management

Creating Rooms

Add New Room

Select Room tool from toolbar

Click on canvas to place room rectangle

Drag corners to resize

Room Properties

Name: Descriptive room names

Type: Office, Mechanical, Storage, etc.

Color: Visual identification

HVAC Zone: Assignment to control zones

Empty Room Policy

All rooms start empty by default

No pre-filled equipment or furniture

User manually places all equipment

Room Types Available

Office: Standard workspace areas

Conference Room: Meeting spaces

Mechanical Room: Equipment areas

Storage: Storage spaces

Restroom: Bathroom facilities

Kitchen: Food service areas

Lobby: Reception and waiting areas

Hallway: Circulation spaces

Server Room: IT equipment areas

Laboratory: Specialized workspaces
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Equipment Placement

NexusConnectBridge Component Integration

The Floor Plan Designer integrates with the complete NexusConnectBridge Component Library:

Library  Statistics: -  Total  Components:  202  professional  HVAC  components  -  2D  SVG

Components:  95  high-quality  vector  graphics  -  3D  GLB  Models:  107  detailed  3D  models  -

Categories: Structure, HVAC, Piping, Valves, Sensors, Controls

Placing Equipment

Access Component Library

Left panel shows two tabs: "Standard" and "3D"

Search by name or browse by category

Component Selection

Click component in library to select

Preview shows 2D/3D availability indicators

Placement

Click on canvas to place equipment

Component automatically resizes to appropriate scale

Visual Indicators

Green dot + "2D": Component uses NexusConnectBridge SVG

Green dot + "3D": Component has 3D GLB model available

Standard colors: Default representation

Equipment Categories

HVAC Equipment: - Air Handling Units (AHU) - Variable Air Volume (VAV) boxes - Fans and blowers

- Chillers and cooling towers - Boilers and heat exchangers - Pumps and circulation equipment

Control Components: - Temperature sensors - Humidity sensors - Pressure sensors - Thermostats

- BMS controllers - Control panels

Safety  &  Monitoring: -  Smoke  detectors  -  Fire  dampers  -  Emergency  controls  -  Monitoring

equipment
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Equipment Management

Selection  and  Editing: -  Select:  Click  component  to  highlight  with  blue  border  -  Move:  Drag

selected component to new position - Rotate: Use rotation tool or properties panel - Delete: Select

component and press Delete or Backspace - Properties: Right-click for component properties

Keyboard Controls: - Delete/Backspace: Remove selected component - ESC: Clear selection and

cancel operations - Ctrl+Z: Undo last action - Ctrl+Y: Redo action

3D Visualization

3D View Mode

Access professional 3D rendering by clicking the "3D View" button in the toolbar.

3D  Rendering  Features: -  Isometric  Projection:  Professional  architectural  3D view -  Real-time

Rendering: Instant updates as you design - Component Integration: Shows actual 3D GLB models

from NexusConnectBridge - Depth and Shadows: Realistic lighting and depth perception

3D Components Display

3D Equipment Rendering: - Loads actual 3D GLB models from component library - Proper scaling

and positioning - Material and texture rendering - Connection point visualization

3D Room Volumes: - Shows room height and 3D space - Wall extrusion with proper thickness -

Ceiling and floor surfaces - Lighting and shadow effects

3D Navigation: - Pan: Mouse drag to move view - Zoom: Mouse wheel to zoom in/out - Reset: ESC

to return to 2D view

Hybrid Mode

3D Overlay Features: - 2D floor plan as base layer - 3D equipment shadows and indicators - Height

visualization lines - Component availability indicators

Piping & Ductwork

Piping System Design

Select Piping Tool

Click Piping button in toolbar

Piping controls panel appears

Piping Configuration
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Pipe Size: 0.5" to 24" diameter

Material: Steel, copper, PVC, stainless, PEX

Type: Supply, return, steam, condensate

Insulation: Insulated or bare pipe

Drawing Piping

Click to start pipe route

Click additional points to create route

Right-click to complete pipe run

Connection Management

Automatic connection to equipment

Connection point validation

Flow direction indicators

Ductwork System Design

Select Ductwork Tool

Click Ductwork button in toolbar

Ductwork controls panel appears

Ductwork Configuration

Width: 6" to 48"

Height: 4" to 24"

Material: Galvanized steel, aluminum, fiberglass, flexible

Type: Supply, return, exhaust, intake

Drawing Ductwork

Click to start duct route

Visual rectangular duct representation

Automatic sizing and transitions

3D Ductwork Visualization

Rectangular duct cross-sections in 3D

Proper routing around obstacles

Connection fittings and transitions
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Layer Management

Layer Visibility Controls

Access layer controls via the Layers button in toolbar.

Available Layers: - Building Structure - Floors - Walls

- Rooms - HVAC Systems - HVAC Equipment - Piping - Ductwork - Controls & Sensors - Sensors -

Thermostats - Controllers - Connections

Layer Operations: - Show/Hide: Toggle individual layers - Show All: Make all layers visible - Hide

All: Hide all layers for clean view

Performance Optimization

Large  Project  Management: -  Hide  unused  layers  for  better  performance  -  Focus  on  specific

systems during design - Use layer isolation for complex projects

Keyboard Shortcuts {#floor-plan-keyboard-shortcuts}

Drawing Tools

S: Select tool

W: Wall drawing tool

R: Room tool

E: Equipment tool

P: Piping tool

D: Ductwork tool

Navigation

Space + Drag: Pan canvas

Ctrl + Mouse Wheel: Zoom in/out

Ctrl + 0: Fit to screen

G: Toggle grid visibility

Selection and Editing

Delete/Backspace: Remove selected items

ESC: Clear selection, cancel operation
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Ctrl + A: Select all

Ctrl + Z: Undo

Ctrl + Y: Redo

View Controls

1: 2D view mode

3: 3D view mode

H: Hybrid view mode

L: Toggle layer panel

F: Full screen mode

Project Management

Ctrl + S: Save project

Ctrl + O: Open project

Ctrl + N: New project

Ctrl + E: Export project

NexusForge AI Integration

AI-Assisted Design

The Floor Plan Designer integrates with NexusForge AI for intelligent design assistance.

NexusForge Capabilities: -  Layout Optimization: Suggest efficient floor plan layouts - Equipment

Sizing:  Recommend  proper  equipment  for  spaces  -  Energy  Analysis:  Analyze  HVAC  load

requirements  -  Code  Compliance:  Check building code compliance -  Design  Validation:  Verify

system compatibility

Using NexusForge Chat

Open Chat Panel

Click "NexusForge Chat" button in toolbar

Chat panel slides in from right side

Design Assistance Commands

"Create a small office layout"
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"Add an AHU to the mechanical room"

"Optimize the HVAC routing"

"Check energy efficiency"

AI Responses

Intelligent design modifications

Equipment recommendations

Layout optimizations

Professional guidance

AI-Powered Features

Smart  Placement: -  Automatic equipment positioning -  Optimal  equipment sizing -  Zone-based

equipment assignment

Layout  Generation: -  Template-based  floor  plans  -  Industry-standard  layouts  -  Custom  space

planning

System  Integration: -  Compatible  equipment  selection  -  Proper  connection  routing  -  Load

balancing recommendations

Export and Integration

Export Options

2D Exports: - PDF: Professional architectural drawings - DWG: AutoCAD format for further editing -

SVG: Scalable vector graphics - PNG: High-resolution images

3D Exports: -  3D Model: GLB format for 3D viewers -  Rendered Images: Photorealistic renders -

VR/AR: Virtual reality walkthrough files

Integration with Other Modes

Floor  Plan  →  Control  Mode: -  Equipment  list  transfer  -  Component  specifications  -  Electrical

requirements - Control point mapping

Floor Plan → AI Model: - Building parameters - Equipment specifications - Energy modeling data -

Performance metrics
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Best Practices

Professional Design Workflow

Start with Building Shell

Draw exterior walls first

Add interior walls and partitions

Define rooms and spaces

HVAC System Design

Place major equipment (AHU, chillers)

Add distribution equipment (VAV boxes)

Route main ductwork and piping

Add terminal equipment

Controls Integration

Place sensors and controllers

Define control zones

Map control connections

Validation and Review

Check 3D visualization

Verify equipment accessibility

Review system integration

Export final drawings

Performance Tips

Optimize Performance: -  Use layers to manage complex designs - Hide unnecessary elements

during design - Save frequently for large projects - Use grid snapping for precision

Quality  Control: -  Regular  3D  view  checks  -  Equipment  clearance  verification  -  System

compatibility validation - Professional drawing standards
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Control Mode - HVAC Schematic Design

Component Library

Accessing Components

Expand categories by clicking the arrow icons:

Controllers: PLCs, DDC controllers, smart thermostats

Sensors: Temperature, humidity, pressure, flow

Actuators: Damper actuators, valve actuators

Equipment: AHUs, chillers, boilers, pumps, fans

Electrical: Relays, contactors, transformers

Safety: Emergency stops, fire dampers

Use the search box to quickly find components:

Type component names or part numbers

Search by manufacturer or model

Use keywords like "temperature" or "valve"

Adding Components to Canvas

Method 1: Drag and Drop 1. Select a component from the library 2. Drag it to the desired location

on canvas 3. Drop it - the component will snap to grid

Method 2: Double-Click 1.  Double-click a component in the library 2. Click on the canvas where

you want to place it 3. Press Esc to exit placement mode

Component Properties

After  placing  a  component:  1.  Click  to  select the  component  (blue  outline  appears)  2.  View

properties in  the  right  panel:  -  Tag/Designation:  Unique identifier  (e.g.,  TE-101)  -  Description:

Component  function  description  -  Manufacturer:  Equipment  manufacturer  -  Model  Number:

Specific part number - I/O Points: Input/output configuration - Wiring: Terminal connections

Canvas Operations

Navigation

Zoom In: Scroll up or Ctrl/Cmd + Plus
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Zoom Out: Scroll down or Ctrl/Cmd + Minus

Pan: Click and drag empty space

Fit to Screen: Double-click empty space

Selection

Single Select: Click on component

Multi-Select: Ctrl/Cmd + Click multiple components

Area Select: Drag rectangle around components

Select All: Ctrl/Cmd + A

Moving Components

Select component(s) you want to move

Drag to new location - components snap to grid

Use arrow keys for precise positioning

Hold Shift + arrow keys for larger movements

Copying and Pasting

Select components to copy

Press Ctrl/Cmd + C to copy

Press Ctrl/Cmd + V to paste

Move copied components to desired location

Deleting Components

Select components to delete

Press Delete key or Backspace

Confirm deletion in popup dialog

Wire Routing

Creating Wires

Method 1: Wire Tool 1. Select wire tool from toolbar 2. Click starting terminal on first component 3.

Click ending terminal on second component 4. Wire is automatically routed with smart pathfinding
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Method 2: Drag Connection 1.  Hover over component terminal until connection point appears 2.

Click and drag to target terminal 3. Release when target is highlighted

Wire Properties

Select a wire by clicking on it

Configure properties in right panel:

Wire Type: Control, power, signal, network

Conductor Size: AWG sizing (14, 12, 10, etc.)

Insulation: THW, THWN, XHHW

Color Code: Standard electrical colors

Cable Type: Individual wires or multi-conductor cable

Voltage Rating: 24V, 120V, 208V, 480V

Wire Routing Options

Automatic Routing: Smart pathfinding avoids obstacles

Manual Routing: Click to add waypoints for custom paths

Orthogonal: Right-angle routing for professional appearance

Direct: Straight-line connections

Wire Labels

Double-click on wire to add label

Enter wire designation (e.g., W1, Control-1, 24VAC)

Position label by dragging

Configure label properties: font, size, color

Properties Configuration

Component Configuration

Basic  Properties: -  Tag:  Unique  component  identifier  -  Description:  Functional  description  -

Location: Physical location in building

Electrical  Properties: -  Voltage:  Operating voltage (24VAC,  120VAC,  etc.)  -  Current:  Operating

current - Power: Power consumption - I/O Type: Analog input, digital output, etc.
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Physical Properties: -  Manufacturer: Equipment manufacturer -  Model: Specific model number -

Part Number: Exact part number for procurement - Specifications: Technical specifications

Validation Features

The system automatically validates: -  Electrical compatibility between connected components -

Voltage mismatches (warnings for incompatible voltages) - Current overloads (alerts for excessive

current draw) - I/O type compatibility (analog vs. digital matching)

Project Information

Title Block Configuration

Click "Project Information" in properties panel

Fill in required fields:

Company Information: - Company Name: Your organization name - Address: Company address -

Phone/Email: Contact information

Project  Details: -  Project  Name:  Descriptive  project  name  -  Project  Location:  Building/facility

location -  Project  Number:  Internal  project  reference -  Contract  Number:  Contract  reference if

applicable

Drawing Information: -  Drawing Title:  Specific drawing description -  Drawing Number:  Unique

drawing identifier - Sheet Number: Current sheet (e.g., "1 of 3") - Revision: Drawing revision letter/

number - Scale: Drawing scale (e.g., "NTS" - Not to Scale)

Personnel: -  Drawn By: Designer/engineer name -  Checked By: Reviewer name -  Approved By:

Approval authority - Date: Creation/revision date
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BMS Integration Workflow

Uploading BMS Configuration

Preparing Configuration Files

Supported Formats: -  HTML files containing BAS (Building Automation System) data -  Exported

from: Johnson Controls, Honeywell, Schneider Electric, Tridium - File size limit: 50MB maximum

Upload Process

Click "Config" button in the toolbar

Select "Upload BMS Configuration"

Choose your HTML file from file browser

Wait for validation - system checks file format and content

Review parsing results - system extracts:

I/O points and addresses

Controller information

System sequences

Equipment specifications

Validation Messages

Success Messages: - ✅ "BMS configuration parsed successfully" - ✅ "Found X controllers, Y points"

- ✅ "Ready for schematic generation"

Warning Messages: - ⚠ "Some data could not be parsed" - ⚠ "Missing equipment specifications" -

⚠ "Non-standard format detected"

Error Messages: - ❌ "Invalid file format" - ❌ "File size exceeds limit" - ❌ "Corrupted or empty file"

Uploading Control Logic

Preparing Logic Files

Supported Formats: -  JavaScript (.js) files containing control logic - Production-ready logic with

proper syntax - Commented code for better understanding
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Content  Examples: -  PID  control  algorithms  -  Sequencing  logic  -  Safety  interlocks  -  Alarm

conditions - Scheduling routines

Upload Process

Click "Logic" button in the toolbar

Select "Upload Control Logic"

Choose your JavaScript file

Wait for syntax validation

Review logic analysis:

Function definitions found

Variable declarations

Control loops identified

Safety checks detected

Automatic Schematic Generation

Triggering Generation

Automatic Trigger: - When both config AND logic files are uploaded - System automatically starts

schematic generation - Progress indicator shows generation status

Manual Trigger: 1.  Click "Generate Schematic" button 2.  Confirm generation in popup dialog 3.

Wait for completion (typically 10-30 seconds)

Generation Process

Phase  1:  Analysis (2-5  seconds)  -  Parsing  BMS  configuration  data  -  Analyzing  control  logic

structure - Identifying equipment relationships

Phase 2: Component Placement (5-15 seconds) - Creating component instances - Applying IEEE

standard symbols - Calculating optimal layout

Phase 3: Wire Routing (3-10 seconds) - Connecting related components - Routing wires with smart

pathfinding - Applying electrical standards

Phase 4:  Finalization (1-3 seconds) -  Adding labels and designations - Generating title block -

Performing final validation
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Generated Elements

Components  Created: -  Controllers  (with  correct  model  numbers)  -  Sensors  (with  proper  I/O

assignments) - Actuators (with control signals) - Equipment (AHUs, pumps, etc.) - Safety devices

(as specified in logic)

Connections Made: - Power supply wiring - Control signal routing - Communication networks -

Safety interlock chains

Labels Applied: -  Component tags (TE-1,  UC-1,  etc.)  -  Wire designations - System identifiers -

Professional nomenclature

Logic Generation

Accessing Logic Generator

Click "Generate Logic" button in toolbar

Select equipment type from the modal:

Air Handling Unit (AHU)

Variable Air Volume (VAV)

Chiller

Boiler

Cooling Tower

Dedicated Outdoor Air System (DOAS)

Pump

Greenhouse Control

Steam Boiler

Equipment Configuration

For Air Handling Units: - Supply fan control: VFD or constant speed - Return/exhaust fan: Optional

configuration -  Heating coil:  Hot water,  steam, or electric -  Cooling coil:  Chilled water or DX -

Economizer:  Optional  free  cooling  -  Filters:  Pressure  monitoring  -  Safety  features:  Fire/smoke

dampers

For  VAV  Terminals: -  Airflow  control:  Pressure  independent  -  Reheat:  Hot  water  or  electric  -

Damper  control:  Actuator  type  -  Occupancy:  Scheduled  or  sensor-based  -  Setpoint  reset:

Temperature compensation
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Generated Logic Features

Control Algorithms: -  PID Control:  Tuned parameters for equipment type -  Sequencing:  Staged

equipment operation - Optimization: Energy efficiency algorithms - Safety: Comprehensive safety

interlocks

Code Quality: - Professional Standards: Industry best practices - Documentation: Comprehensive

commenting - Error Handling: Robust error management - Maintainability: Clear variable naming

Output Format: -  JavaScript file:  Ready for implementation -  Commented code:  Explanation of

logic - Configuration: Equipment-specific settings - Test procedures: Commissioning guidelines

AI Model Mode - Machine Learning Integration

AI Model Canvas

Interface Overview

Layout: - Left Panel: AI component library - Center Canvas: Visual model design area - Right Panel:

Model properties and configuration - Bottom Panel: Dataset integration and training controls

AI Components

Input Layers: - Data Input: Time series, sensor data - Feature Input: Engineered features - Image

Input: Thermal imaging, visual data

Processing Layers: - Dense Layers: Fully connected neurons - LSTM: Long Short-Term Memory for

sequences -  CNN:  Convolutional  layers  for  patterns -  GRU:  Gated Recurrent  Units  -  Attention:

Transformer attention mechanisms

Output Layers: - Classification: Categorical predictions - Regression: Continuous value prediction

- Time Series: Future value forecasting - Anomaly Detection: Fault identification

Creating AI Models

Select input layer from component library

Drag to canvas and configure input dimensions

Add processing layers by connecting components

1. 
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Configure layer parameters:

Number of neurons/units

Activation functions

Dropout rates

Regularization

Add output layer with appropriate activation

Connect all layers in logical sequence

Validate model architecture

Dataset Integration

HVAC Dataset Library

72 Curated Datasets Available:

Fault Detection Datasets (24): - SHIFDR Michigan Buildings (500MB) - LBNL Complete FDD System

(500MB) - LBNL Chiller Plant (1.14GB) - ASHRAE RP-1043 Chiller Data (49MB) - Multi-Building FDD

Collection - Industrial Boiler Operations (11MB)

Building Reference Datasets (18): - DOE Commercial Reference Buildings - Warehouse operational

data - Hospital HVAC systems - Office building performance - School energy systems

Performance  Analytics  (12): -  Equipment  efficiency  analysis  -  Energy  optimization  studies  -

Comfort analysis datasets - Retrofit performance data

Dataset Selection Process

Click "Import Dataset" in AI Model mode

Browse dataset categories:

Fault Detection

Building Reference

Performance Analytics

Energy Efficiency

Simulation Data

Research Data

Filter by criteria:

Equipment type (AHU, chiller, boiler)
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Data size and duration

Source organization

Data quality rating

Preview dataset information:

Data description and specifications

Download size and format

Source URL and documentation

Sample data preview

Select and download chosen datasets

Data Preprocessing

Automatic  Preprocessing: -  Missing  value  handling  -  Outlier  detection  and  treatment  -  Data

normalization/standardization - Feature engineering suggestions

Manual  Configuration: -  Custom  preprocessing  pipelines  -  Feature  selection  tools  -  Data

transformation options - Quality assessment metrics

Model Training Setup

Training Configuration

Basic  Parameters: -  Learning  Rate:  0.001  (default,  adjustable)  -  Batch  Size:  32,  64,  128,  256

options -  Epochs: Number of training iterations -  Validation Split: Percentage for validation (20%

default)

Advanced Options: - Optimizer: Adam, SGD, RMSprop - Loss Function: MSE, MAE, Cross-entropy

-  Metrics:  Accuracy,  F1-score,  RMSE  -  Early  Stopping:  Prevent  overfitting  -  Learning  Rate

Scheduling: Adaptive rates

Training Monitoring

Real-Time Metrics: - Training and validation loss - Accuracy progression - Learning rate evolution -

Training time estimation

Visualizations: -  Loss  curves  (training  vs  validation)  -  Metric  progression  charts  -  Confusion

matrices (classification) - Feature importance plots
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Model Export Options

Format Options: -  TensorFlow SavedModel: For TensorFlow deployment -  ONNX: Cross-platform

compatibility - PyTorch: Native PyTorch format - Jupyter Notebook: Complete training pipeline

3D Visualization

Neural Network 3D View

Features: -  Interactive  3D  rendering of  neural  network  architecture  -  Layer  visualization with

neuron representations - Connection mapping showing weight strengths - Animation of data flow

through network

Controls: - Rotate: Click and drag to rotate view - Zoom: Scroll or pinch to zoom in/out - Pan: Right-

click and drag to pan - Reset View: Double-click to reset camera

Data Flow Animation

Click "Animate Data Flow" button

Select input data for visualization

Watch data propagate through layers

Observe activations in real-time

Analyze output generation process

BMS-to-AI Workflow

Creating AI Models from BMS Data

Workflow Overview

The BMS-to-AI workflow creates machine learning models specifically designed for your BMS data:

BMS Config Upload → Logic Analysis → AI Model Creation → Dataset Selection → Training Setup
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Accessing BMS-to-AI

Upload BMS configuration and logic files first

Click "AI Model" button in toolbar

Select "Create AI Model from BMS"

Choose your model purpose from options

Purpose Selection

Available AI Model Purposes

1.  Control  Optimization -  Purpose:  Optimize  HVAC  control  parameters  -  Input:  Setpoints,

schedules,  equipment  status  -  Output:  Optimized  control  parameters  -  Applications:  Energy

savings, comfort improvement

2. Fault Detection & Diagnostics (FDD) - Purpose: Identify equipment malfunctions - Input: Sensor

readings,  equipment  status  -  Output:  Fault  probability,  fault  type  -  Applications:  Predictive

maintenance, system reliability

3. Alarm Management - Purpose: Intelligent alarm filtering and prioritization - Input: Alarm history,

system status - Output: Alarm severity, root cause analysis - Applications: Reduced false alarms,

faster response

4.  Performance  Monitoring -  Purpose:  Track  and  analyze  equipment  performance  -  Input:

Operational  data,  efficiency  metrics  -  Output:  Performance  indicators,  trends  -  Applications:

Efficiency tracking, benchmarking

5. Energy Optimization -  Purpose: Minimize energy consumption - Input: Energy usage, weather,

occupancy - Output: Optimal operating strategies - Applications: Cost reduction, sustainability

6. Sequence Optimization -  Purpose: Optimize equipment sequencing -  Input: Equipment status,

load conditions -  Output: Optimal start/stop sequences -  Applications: Equipment life extension,

efficiency

Dataset Recommendations

Automatic Recommendations

Based on your selected purpose and uploaded BMS data:

For Fault Detection Models: - LBNL Complete FDD System - SHIFDR Michigan Buildings - Multi-

Building FDD Collection - ASHRAE RP-1043 Chiller Data
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For  Control  Optimization: -  DOE  Reference  Building  Data  -  Performance  Analytics  Datasets  -

Energy Efficiency Collections

For  Performance Monitoring: -  Industrial  Boiler  Operations -  Equipment  Performance Studies -

Efficiency Analysis Datasets

Smart Matching Algorithm

The system analyzes your BMS configuration and recommends datasets based on: -  Equipment

types present  in  your  system  -  System  size and  complexity  -  Building  type and  usage  -

Geographic location and climate - Data availability and quality

Training Notebook Generation

Automatic Generation

Complete purpose selection and dataset selection

Click "Generate Training Notebook"

System creates comprehensive Jupyter notebook with:

Data loading and preprocessing code

Model architecture based on your BMS

Training pipeline configuration

Evaluation and validation metrics

Deployment instructions

Notebook Contents

Section 1: Data Setup

<h1 id="automatic-data-loading-from-selected-datasets">Automatic data loading from selected datasets//h1>
<h1 id="preprocessing-pipeline-configuration">Preprocessing pipeline configuration//h1>
<h1 id="feature-engineering-for-your-specific-bms">Feature engineering for your specific BMS//h1>

Section 2: Model Architecture
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<h1 id="neural-network-design-based-on-your-equipment">Neural network design based on your equipment//h1>
<h1 id="layer-configuration-optimized-for-hvac-data">Layer configuration optimized for HVAC data//h1>
<h1 id="custom-loss-functions-for-hvac-applications">Custom loss functions for HVAC applications//h1>

Section 3: Training Pipeline

<h1 id="training-loop-with-monitoring">Training loop with monitoring//h1>
<h1 id="validation-and-testing-procedures">Validation and testing procedures//h1>
<h1 id="hyperparameter-optimization">Hyperparameter optimization//h1>

Section 4: Evaluation

<h1 id="performance-metrics-calculation">Performance metrics calculation//h1>
<h1 id="visualization-of-results">Visualization of results//h1>
<h1 id="model-interpretation-tools">Model interpretation tools//h1>

Section 5: Deployment

<h1 id="model-export-for-production">Model export for production//h1>
<h1 id="integration-with-bms-systems">Integration with BMS systems//h1>
<h1 id="realtime-inference-setup">Real-time inference setup//h1>

Google Colab Integration

Notebook automatically configured for Google Colab

One-click deployment to Colab environment

GPU training enabled for faster model training

Automatic result synchronization back to NexusConnect
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Project Management

Creating New Projects

Starting a New Project

Click "File" menu in toolbar

Select "New Project"

Choose project template:

Blank Project: Start from scratch

BMS Integration: Pre-configured for BMS workflow

AI Model Project: Set up for machine learning

Template Library: Industry-specific templates

Configure project settings:

Project name and description

Default components and libraries

Drawing standards and preferences

Team collaboration settings

Project Templates

Commercial HVAC Templates: - Office Building Controls - Hospital HVAC Systems - School Energy

Management - Retail Store Controls - Warehouse Management

Industrial  Templates: -  Manufacturing Plant  Controls  -  Data  Center  Cooling -  Food Processing

Facilities - Pharmaceutical Clean Rooms - Chemical Plant Controls

Saving and Loading

Auto-Save Feature

Automatic saving every 2 minutes

Version history maintained

Conflict resolution for multiple users

Save status indicator in toolbar
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Manual Save Operations

Save Project: 1.  Press Ctrl/Cmd + S or click File → Save 2.  Enter save description (optional) 3.

Choose save location (local or cloud)

Save  As: 1.  Click  File  →  Save  As 2.  Enter  new  project  name 3.  Select  destination  folder 4.

Configure sharing settings

Export Options: - PDF Export: Professional drawings - DWG Export: AutoCAD compatibility - SVG

Export:  Scalable vector graphics -  PNG/JPG Export:  Raster images -  JSON Export:  Raw project

data

Loading Projects

Recent Projects: -  Quick access from File menu -  Thumbnail previews of project content -  Last

modified dates and times - Collaboration status indicators

Browse Projects: 1.  Click File → Open 2.  Navigate to project folder 3.  Preview project details 4.

Open selected project

Google Drive Integration

Setting Up Google Drive

Click "Connect Google Drive" in File menu

Authenticate with Google account

Grant permissions for file access

Select sync folder for NexusConnect projects

Cloud Sync Features

Automatic  Synchronization: -  Real-time  sync of  project  changes  -  Conflict  resolution for

simultaneous edits - Version history in Google Drive - Offline access with sync on reconnect

Team Collaboration: - Share projects with team members - Real-time collaboration on schematics

- Comment and review system - Access control and permissions

Sync Status Indicators

☁ Cloud synced: Project is up to date in cloud

🔄 Syncing: Changes are being uploaded

⚠ Sync conflict: Manual resolution required
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📴 Offline: No internet connection

Project Export

Export Formats

Professional  Drawings (PDF): -  High-resolution output (300 DPI  minimum) -  Professional  title

blocks with  company branding -  IEEE  standard  symbols and nomenclature  -  Layered  PDF for

selective printing

CAD  Integration  (DWG): -  AutoCAD  compatibility (versions  2018-2024)  -  Proper  layer

organization - Block definitions for components - Dimension and annotation preservation

Web Formats: - Interactive SVG: Zoomable vector graphics - HTML5 Canvas: Web-based viewing

- 3D Models: WebGL for 3D components

Export Settings

Quality Options: - Print Quality: 300 DPI for professional printing - Web Quality: 150 DPI for digital

sharing - Draft Quality: 72 DPI for quick review

Content Selection: -  All Layers: Complete project export -  Visible Layers: Only currently visible

content -  Selected Components:  Export  specific elements -  Custom Sheets:  Multi-page export

options

Advanced Features

Component Builder

Creating Custom Components

Access Component Builder from Tools menu

Start with base template or create from scratch

Design component symbol:

Draw using vector tools

Add terminal connection points
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Configure symbol properties

Apply IEEE standards

Configure component properties:

Electrical characteristics

Physical dimensions

Manufacturer information

Part numbers and specifications

Symbol Design Tools

Drawing Tools: -  Line Tool: Create symbol outlines -  Circle/Rectangle: Basic shapes -  Arc Tool:

Curved elements - Text Tool: Component labels - Dimension Tool: Size annotations

Connection Points: -  Input Terminals: Signal inputs -  Output Terminals: Signal outputs -  Power

Connections: Electrical supply - Communication: Network connections

Component Library Management

Organization: -  Custom  Categories:  Create  your  own  categories  -  Tagging  System:  Add

searchable tags - Version Control: Track component revisions - Sharing: Export/import component

libraries

Template System

Using Project Templates

Template Categories: - Industry Standards: IEEE, NEMA, IEC templates - Equipment Types: AHU,

chiller, boiler templates - Building Types: Office, hospital, school layouts - System Types: Controls,

safety, monitoring

Creating Custom Templates

Design your standard layout

Save as template from File menu

Configure template properties:

Template name and description

Default components included

Standard wire types and colors

Title block configuration
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Share with team or organization

Electrical Validation

Real-Time Validation

Automatic  Checks: -  Voltage  compatibility:  Warns of  voltage mismatches -  Current  capacity:

Alerts for overloaded circuits - Wire sizing: Suggests proper conductor sizes - Protection: Validates

fuse and breaker ratings

Safety  Validation: -  Grounding:  Ensures  proper  grounding  connections  -  GFCI  Requirements:

Identifies GFCI-required circuits - Arc Fault: Validates arc fault protection - Emergency Shutdown:

Verifies safety shutoffs

Validation Reports

Error  Report: -  Lists  all  electrical  violations  -  Provides  correction  recommendations  -  Links  to

relevant code sections - Severity ratings (critical, warning, info)

Compliance  Report: -  Confirms  standards  compliance  -  Documents  validation  timestamps  -

Includes engineer approval - Ready for submittal

Professional Standards Compliance

Supported Standards

Electrical Standards: -  NEC (National Electrical Code): US electrical standards -  IEEE Standards:

Professional  symbols  and practices  -  IEC  Standards:  International  electrical  standards  -  NEMA

Standards: Enclosure and component standards

HVAC Standards: - ASHRAE Standards: HVAC design and operation - SMACNA Standards: Sheet

metal  and  air  conditioning  -  NEBB  Standards:  Testing  and  balancing  -  AABC  Standards:

Commissioning procedures

Compliance Features

Symbol  Libraries: -  IEEE-compliant  electrical  symbols  -  ASHRAE-standard  HVAC  symbols  -

Manufacturer-specific components - Custom symbol validation

Drawing Standards: - Professional line weights and styles - Standard text fonts and sizes - Proper

dimensioning practices - Title block requirements
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Troubleshooting

Common Issues

Login Problems

Issue:  Cannot log in to NexusConnect  Solutions: 1.  Check internet  connection -  ensure stable

connection 2.  Clear browser cache - delete cookies and cached data 3.  Try different browser -

Chrome, Firefox, Safari, Edge 4. Check username/password - ensure correct credentials 5. Reset

password if forgotten 6. Contact support if issue persists

Issue:  "Remember Me" not  working  Solutions: 1.  Enable cookies in  browser settings 2.  Check

private/incognito mode - doesn't save login 3. Clear browser data and re-login 4. Update browser

to latest version

File Upload Issues

Issue: BMS configuration file won't upload Solutions: 1. Check file format - must be HTML format

2.  Verify file size - maximum 50MB allowed 3.  Check file content - ensure valid BAS data 4.  Try

different file to isolate issue 5. Contact support with file details

Issue:  Control  logic  upload fails  Solutions: 1.  Validate  JavaScript  syntax -  check for  errors  2.

Remove  special  characters in  filename  3.  Ensure  file  encoding is  UTF-8  4.  Check  file  size

limitations 5. Test with simple logic file first

Performance Issues

Issue: Application running slowly Solutions: 1. Check system requirements - meet minimum specs

2. Close other browser tabs - free up memory 3. Restart browser - clear memory leaks 4. Update

graphics drivers - especially for 3D features 5. Check internet speed - minimum 10 Mbps required

Issue: Canvas not responsive Solutions: 1. Zoom out to reduce rendering load 2. Simplify project -

remove unnecessary components 3. Clear browser cache and reload 4. Try different browser for

compatibility 5. Update browser to latest version

AI Model Issues

Issue:  Dataset  download  fails  Solutions: 1.  Check  internet  connection stability  2.  Try  smaller

datasets first 3. Clear browser cache and retry 4. Check available storage space 5. Use different

network if possible
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Issue: Model training not starting  Solutions: 1.  Verify dataset selection - at least one required 2.

Check model architecture - ensure valid connections 3. Validate training parameters - reasonable

values 4. Try simpler model first 5. Check browser console for error messages

Error Messages

Authentication Errors

Error:  "Invalid  username  or  password"  -  Cause:  Incorrect  login  credentials  -  Solution:  Verify

username and password, reset if necessary

Error:  "Session  expired"  -  Cause:  Login  session  timed  out  -  Solution:  Log  in  again,  enable

"Remember Me" option

Error:  "Account locked" -  Cause:  Too many failed login attempts -  Solution:  Wait 15 minutes or

contact support

File Upload Errors

Error: "File format not supported" - Cause: Wrong file type uploaded - Solution: Ensure HTML for

config, JavaScript for logic

Error:  "File  too  large"  -  Cause:  File  exceeds  50MB  limit  -  Solution:  Compress  file  or  remove

unnecessary data

Error: "Upload timeout" - Cause: Slow internet connection - Solution: Check connection speed, try

again

Validation Errors

Error: "Voltage mismatch detected" - Cause: Components with incompatible voltages connected -

Solution: Check component specifications, use compatible voltages

Error: "Wire gauge undersized" -  Cause: Wire too small for current load - Solution: Increase wire

gauge or reduce load

Error: "Missing ground connection" -  Cause: Component requires grounding but none provided -

Solution: Add proper grounding connection
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Performance Tips

Browser Optimization

Chrome Settings: 1. Enable hardware acceleration in Settings → Advanced → System 2. Increase

memory allocation for  JavaScript  3.  Disable unnecessary extensions that  use memory 4.  Use

Chrome's task manager to monitor resource usage

Firefox Settings: 1. Enable WebGL in about:config 2. Increase DOM worker threads 3. Clear cache

regularly 4. Update to latest version

Project Optimization

Large Projects: -  Use layers to organize complex schematics -  Group related components for

easier  management  -  Minimize  wire  crossings for  clarity  -  Use  standard  components when

possible

Memory  Management: -  Close  unused  projects to  free  memory -  Limit  open  browser  tabs -

Restart browser periodically - Clear temporary files

Network Optimization

For Cloud Sync: -  Use wired connection when possible -  Ensure stable internet (minimum 10

Mbps) - Avoid peak usage times - Monitor data usage for large projects

Support Resources

Documentation

Online Help: -  User Manual:  Complete documentation -  Video Tutorials:  Step-by-step guides -

FAQ: Frequently asked questions - Release Notes: Latest features and fixes

Community Support

User Forums: -  General Discussion: Ask questions, share tips -  Technical Support: Troubleshoot

issues  -  Feature  Requests:  Suggest  improvements  -  User  Contributions:  Share  templates  and

components

Professional Support

Technical  Support: -  Email:  support@automatanexus.com  -  Phone:  1-800-NEXUS-01  -  Hours:

Monday-Friday, 8 AM - 6 PM EST - Response Time: 24 hours for standard, 4 hours for priority
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Training Services: -  Online Training: Self-paced courses -  Live Webinars: Interactive sessions -

On-Site Training: Custom training at your location - Certification: Professional certification program

Appendices

Keyboard Shortcuts

General Navigation

Shortcut Action

Ctrl/Cmd + N New project

Ctrl/Cmd + O Open project

Ctrl/Cmd + S Save project

Ctrl/Cmd + Z Undo

Ctrl/Cmd + Y Redo

Ctrl/Cmd + A Select all

Delete Delete selected

Esc Cancel current operation
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Canvas Operations

Shortcut Action

Space + Drag Pan canvas

Scroll Wheel Zoom in/out

Ctrl/Cmd + 0 Fit to screen

Ctrl/Cmd + 1 Actual size

G Toggle grid

Ctrl/Cmd + D Duplicate selection

Arrow Keys Move selection

Shift + Arrow Move selection (large steps)
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Component Operations

Shortcut Action

W Wire tool

S Select tool

T Text tool

M Move tool

R Rotate selected

F Flip horizontal

Shift + F Flip vertical

Ctrl/Cmd + G Group components

Ctrl/Cmd + Shift + G Ungroup components
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AI Model Mode

File Formats

Supported Import Formats

BMS Configuration: - .html - BAS system exports - .xml - Structured BAS data - .csv - Point lists

and I/O data

Control Logic: - .js - JavaScript control logic - .json - Configuration data - .txt - Plain text logic

Graphics: - .svg - Scalable vector graphics - .dwg - AutoCAD drawings - .dxf - Drawing exchange

format

Supported Export Formats

Professional Drawings: - .pdf - Professional documentation - .svg - Scalable web graphics - .png -

High-resolution images - .jpg - Compressed images

CAD Formats: - .dwg - AutoCAD native format - .dxf - Universal CAD exchange - .step - 3D CAD

format

Data Formats: - .json - Project data - .csv - Component lists - .xml - Structured data export

Shortcut Action

Ctrl/Cmd + T Train model

Ctrl/Cmd + E Export model

Ctrl/Cmd + I Import dataset

F5 Refresh 3D view

Ctrl/Cmd + M Switch to model mode

Ctrl/Cmd + K Switch to control mode
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API Reference

Authentication API

Login:

POST /api/auth/login
{

"username": "string",
"password": "string"

}

Register:

POST /api/auth/register
{

"username": "string",
"email": "string",
"password": "string"

}

Project API

Save Project:

POST /api/projects
{

"name": "string",
"data": "object",
"description": "string"

}

Load Project:

GET /api/projects/{id}
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BMS Integration API

Upload Configuration:

POST /api/bms/config
{

"file": "multipart/form-data"
}

Generate Schematic:

POST /api/bms/generate-schematic
{

"configId": "string",
"logicId": "string"

}

Glossary

Technical Terms

AHU (Air Handling Unit) - Central air treatment equipment that conditions and circulates air

BAS (Building Automation System) - Computer-based control system for building mechanical and

electrical equipment

BMS  (Building  Management  System) -  Comprehensive  system  for  monitoring  and  controlling

building systems

DDC (Direct Digital Control) - Microprocessor-based control system for HVAC equipment

FDD (Fault Detection and Diagnostics) - Automated system for identifying equipment problems

IEEE (Institute of Electrical and Electronics Engineers) - Professional organization that develops

electrical standards

I/O (Input/Output) - Points where the control system interfaces with field devices

PID (Proportional-Integral-Derivative) - Control algorithm that adjusts output based on error

VAV (Variable Air Volume) - HVAC system that varies airflow rather than temperature
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NexusConnect Terms

Canvas - Main design area where schematics are created

Component Library - Collection of available HVAC and electrical components

Properties Panel - Interface for configuring component and project settings

Smart Routing - Automatic wire routing that avoids obstacles

Title Block - Professional drawing border with project information

End of Guide

This comprehensive guide covers all aspects of using NexusConnect for professional HVAC control

system design and AI model development. For additional support, please contact AutomataNexus

technical support.
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